

    
      
          
            
  
Tripal Galaxy Extension Module


Note

The Tripal Galaxy module is currently compatible only with release 19.01 of the Galaxy Project.
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Install Tripal Galaxy


Installation

The Tripal Galaxy module is available as a full Drupal module.  Therefore, it can be installed following the typical Drupal module installation either via the GUI or via Drush.  However it requires a few dependencies:


	curl


	php-curl


	blend4php




Follow the typical method for installation of tools for your operating system to install curl and php-curl.  For example, on Ubuntu systems you can install both curl and php-curl with the following command:

sudo apt-get install php-curl





Additionally, this module requires the presence of the blend4php library [https://github.com/galaxyproject/blend4php].  The blend4php library was developed as part of the Tripal Gateway Project as stand-alone PHP bindings to the Galaxy RESTful API.  It allows any PHP-based web application to communicate with a remote Galaxy instance.  To install blend4php, navigate to the sites/all/libraries directory of your Drupal installation and issue the following command:

git clone https://github.com/galaxyproject/blend4php.git





That’s it!  The library is now available for Drupal to find.  Now, install the Tripal Galaxy module.  We’ll do so here using a Drush command:

drush pm-enable tripal_galaxy





You will be asked if you would like to download and then enable the module.  Now that the Tripal Galaxy module is installed, navigate to the Administration > Tripal > Extensions > Galaxy page via the administrative menu.  At this location is the administrative interface for interacting with remote Galaxy servers.  Near the top of the page are several tabs including Workflows, Job Queue, Usage, Files and Settings.

[image: _images/install.1.png]


Set Permissions

Now that the Tripal Galaxy module is installed, we must set permissions so that users can add submit workflows and administrators can manage the workflows.  To set permissions, navigate to People page and click the Permissions tab in the top right. To allow end-users to submit workflows, you must set the following two permissions found in the Tripal Galaxy and Tripal sections of the permissions page:


	Tripal Galaxy > Execute Published Galaxy Workflows


	Tripal >  Upload files




To allow a user to administer the Tripal Galaxy workflows you must set three permissions for the given role:


	Tripal Galaxy > Administer Galaxy


	Tripal Galaxy > Execute Published Galaxy Workflows


	Tripal >  Upload files





The following screenshot shows an example of the permissions in the Tripal Galaxy section of the Permission page:




[image: _images/install.2.png]

Warning

If your site is not new you may have additional roles.  As a rule you should not give the anonymous user either permission.


  
    

    Option 1: Automatic Webform Creation
    

    

    
 
  

    
      
          
            
  
Option 1: Automatic Webform Creation

The Tripal Galaxy module can automatically connect to a remote Galaxy server, and retrieve information about a workflow. That information is then used to construct an online web form that a site visitor can use to submit the workflow using their own datasets and/or data provided by the site.



	Site-wide Files

	Adding a Remote Galaxy Server

	Adding a New Workflow

	Set User Quotas
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Site-wide Files

The Galaxy workflows allow users to provide their own files, or to use site-wide files that are provided by the site administrators.  As an administrator, you can provide site-wide files for anyone to use in a Galaxy workflow by navigating to the Galaxy administrative page and clicking the Files tab near the top.   The following page appears:

[image: ../_images/site_wide_files.1.png]
Initially, there are no site-wide files available.  You can add a file (such as a whole genome assembly FASTA file) for use in workflows by clicking the Add a New File link. The following page appears.

[image: ../_images/site_wide_files.2.png]
Here you have two options for providing a file.  Either upload the file using the File Upload form or add the URL to the file if it is available from a remote source.  Typically files from remote sources are available with an HTTP URL or FTP URL.   For example, if your site provides whole genome data and the FASTA file for the genome assembly is available for retrieval from an FTP site, you should enter the full FTP URL for the file into the Remote Path field.  Next, you must provide the type of file.  Examples of file types include fasta, fastq, CSV, etc.  You must provide a file type because Galaxy workflows sometimes require specific file types as input.  If an input requires a FASTA file then it expects a fasta file be provided.  Sometimes remote files do not have an appropriate extension to properly determine the file type. Therefore, you must indicate the file type.  Finally, the site’s users should understand what the file is.  Enter a very brief description of the file to help users recognize what it contains.  When completed, click the Add File button.

In keeping with the example provided by the Tripal v3 User’s Guide [https://tripal.readthedocs.io/en/latest/user_guide/example_genomics.html] for Setup of an Example Genomics Site, the following screen shot shows a site-wide file for the JGI Citrus sinensis v1.1 assembly FASTA file that has been added.  Any workflow that expects a FASTA file as input will now be able to use this file in a workflow:

[image: ../_images/site_wide_files.3.png]
If you no longer need a specific file to be available for users you can either disable the file by clicking the Disable link in the Actions column, or you can delete the file by clicking the Delete link. Disabling the file will allow the file to remain as a site-wide file but exclude it from appearing for use in future workflow submissions.
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Adding a Remote Galaxy Server

Before any workflows can be run, at least one remote Galaxy server must be integrated with Tripal.  This can be done on the Tripal Galaxy administrative page.  This page is available by navigating to  Administration > Tripal > Extensions > Galaxy. The following page is presented:

[image: ../_images/remote_servers.1.png]
We can add a new remote Galaxy server by clicking the Add Galaxy Instance link.  The following page appears:

[image: ../_images/remote_servers.2.png]
Here you can provide the details for the remote Galaxy instance.  This can be a Galaxy instance that was setup and created specifically and dedicated for your site to use, a shared Galaxy instance setup at your institution or one of several public Galaxy instances [https://galaxyproject.org/public-galaxy-servers/].  For this tutorial we will use the Galaxy Project’s “Use Galaxy” [https://usegalaxy.org/] public instance.  The following values are therefore provided to the fields:


Example Galaxy Field Values

	Field Name

	Value





	Galaxy Server Name

	Use Galaxy Public Server



	Description

	The Galaxy Project’s public server.  Does not provide all tools that may be needed, size and responsiveness is limited.



	URL

	https://usegalaxy.org/



	User Name

	[The name of a user account on the Galaxy server]



	API Key

	[The API Key of the user]






The fields described above provide everything needed to connect to a remote Galaxy instance. These incluede the URL, user name of a user on the remote Galaxy server and the API Key for that user.  The Galaxy Server Name field and Description field are meant for you and the site’s users to know where computation is happening and the Description field is for the site admin.

The user name provided will be the account under which all Galaxy workflows will be executed, but the Tripal Galaxy module will ensure that each workflow submission runs independent of all others within this user account.  It is recommended to create a service account on the remote Galaxy instance that is independent of a real person.  This service account can be specific for your website only.

On Galaxy, each user has an API Key. It is via this key that Galaxy will allow remote connections from a client application like Tripal.  To retrieve the API key for your service account user, log on to the remote Galaxy instance and navigate to User > Preferences > Manage API Key.  By default, user’s do not have an API key.  You can generate a key by clicking the link to generate a new key.  Once the key is generated you must cut-and-paste the key into the API Key field of the Tripal Galaxy Instance setup form (shown above).  Clikc the Test Connection button to make sure all details are correct and you can successfully connect using the user name and API Key.  Then once successful, click the Submit button when done.

Now we can see that we have a Galaxy server available:

[image: ../_images/remote_servers.3.png]
You can edit or re-test connectivity to the server by clicking the edit or test links in the Options column.
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Adding a New Workflow

Now that Tripal is aware of a Remote Galaxy server we can integrate workflows with the site.  To do this, navigate to the Tripal Galaxy administration page at Administration > Tripal > Extensions > Galaxy and click the Workflows tab.

[image: ../_images/workflows.1.png]
Currently, there are no workflows available. A workflow can be added by clicking the Add workflows link.  A page appears with a single select box containing a list of Galaxy servers that Tripal knows about.

[image: ../_images/workflows.2.png]
Select a Galaxy server and a list of workflows appears. In the previous Adding a Remote Galaxy Server section we added the UseGalaxy public server.  However, for the remainder of this tutorial we will use a local Galaxy server which has several pre-installed workflows from the Staton Lab Galaxy Workflows library [https://github.com/statonlab/galaxy-workflows].

[image: ../_images/workflows.3.png]
Here we can select any number of workflows to enable on our Tripal site by checking the select box to the left of each workflow and clicking the Submit button.  The Tripal Galaxy module will connect to the remote Galaxy server, retrieve information about the workflow and automatically create a web form for users to submit.  For this example we will enable the workflow named wgcna-analysis (imported from uploaded file) which performs gene co-expression network (GCN) construction.

[image: ../_images/workflows.4.png]
Below is an image of the WGCNA workflow on the Galaxy server:

[image: ../_images/workflows.wgcna.png]
After the workflow has been added to Tripal a message is provided indicating that we may want to adjust the title, instructions and other information about the workflow.  We may want to do this to help improve the user experience for a user who wants to run a workflow and needs details or instructions specific to your site.  To do this, click the link to the workflow in the Workflow Name column.  The following page appears:

[image: ../_images/workflows.5.png]
Tripal Galaxy will provide a set of default introductory instructions which are shown on the page.  The title of the workflow is also not very user friendly. We can first change the title by clicking on the Edit tab.  Here you can change the title to something such as “Co-Expression Network Construction (WGCNA)”

[image: ../_images/workflows.6.png]
Click the Save button.

Next, to update the instructions, click the Webform tab.  Here you will see a list of every field in every step of the workflow.

[image: ../_images/workflows.7.png]

Warning

Be cautious editing any of the fields on the Webform tab as they are needed for the workflow.  It is safe to edit any field of type Markup or, to change the Label and Description.  Do not change the Form Key or any other default values.
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Set User Quotas

One of the most important settings to configure before exposing workflows is User quotas. Setting Quotas is a function provided by Tripal itself and can be found at Administer > Tripal > User File Management under the User Quotas tab.  Instructions for setting User Quotas [https://tripal.readthedocs.io/en/latest/user_guide/file_management.html] are found in the Tripal v3 User’s Guide.
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Option 2: Power an Application

You may not want to expose workflows to end-users via the automatical web forms.  However, you can use the Tripal Galaxy API Functions and blend4php [https://github.com/galaxyproject/blend4php] to directly integrate with Galaxy through your own Tripal application.  To do so, please visit the Tripal Galaxy API Overview pages for more details.

An example application that uses this approach is the Cartogratree [https://treegenesdb.org/ct] application available on the TreeGenes [https://treegenesdb.org] website.
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Workflow Settings

Regardless if you add workflows using option #1 or #2 there are a few settings you can set to customize the way users interact with workflows.  On the workflow administration page at Administer > Tripal > Extension > Galaxy > Workflows you will see a Settings link for each workflow.

[image: _images/workflow_settings.1.png]
Clicking the Settings link beside a workflow will take you to the Settings page for that workflow.


Customizing Emails

Currently the setting page allows you to customize the email text that is sent to end-users when the workflow is invoked and also when it either fails or succeeds.

[image: _images/workflow_settings.2.png]
You can change the text of the subject line and the body of the email by altering the text in the fields.  Additionally, you can use tokens as placeholders for text that you want included in the messages.  You can find a list of available tokens by opening the Available Tokens fieldset. If you do not want a workflow to send email you can disable the email by clicking the checkbox whose title begins: do not send email.

[image: _images/workflow_settings.3.png]
For example, if you want to include the submission time of the workflow in the body of the email that gets sent when the workflow is invoked, you should add the token [submission_init].  When the email is sent this token will be replaced with the submission time.  Be sure to click the Submit button after making any changes.
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Monitoring Usage

Once workflows are made available to end-users you will want to monitor usage. There are two tools to assist with this.  Navigate to the Tripal Galaxy administration pages at Administer > Tripal > Extensions > Galaxy.  You will two tabs named Job Queue and Usage


The Job Queue

The job queue is a tool that lists all of the currently active jobs.  It provides details about who submitted the job, the job state, submission, start and end time.

[image: _images/usage.1.png]
The example above shows the first submission of a Galaxy workflow on our example site. Currently the workflow has a stutus of ‘Waiting’.  The job will stay in the waiting state until the Tripal Job launcher invokes the job.  If you have not setup Tripal for automated job submission, please review the instructions in the Tripal v3 User’s Guide [https://tripal.readthedocs.io/en/latest/user_guide/install_tripal/automating_job_execution.html].

When a job is invoked by the Tripal Job launcher, the following occurs:
1. A history is created uniquely for this workflow submission on the remote Galaxy site.  The Tripal Galaxy module ensures that each workflow submission executes in a unique history.
2. All files needed for the workflow are uploaded to the remote site into the newly created history.
3. Any data collections (groups of files such as paired-data) are organized in the history on the Galaxy server.
4. The workflow is invoked and beings executing on the Galaxy server once resources are available.
5. An email is sent to the end-user indicating that the job has been submitted.

If you were to visit the Galaxy server you should be able to find the history for the submitted workflow and see that the job is running.

[image: _images/usage.2.png]
To do this, you need to know the history name.  You can find the history ID for this submission by clicking on the View Results link in the job queue. The resulting page will indicate that no results are availalbe for non completed jobs, but if you open the Submission Details field set you can find the history name in the table.

[image: _images/usage.3.png]
As the workflow proceeds the status in the job queue is updated until finally the workflow completes:

[image: _images/usage.4.png]


Usage Stats

The Tripal Galaxy Module also provides some simple bar charts indicating the top workflows submitted and users of workflows.  To retrieve these reports navigate to Administer > Tripal > Extensions > Galaxy and click the Usage tab.

The following is an example results for a new site that has had just a few workflows executed by the administrator user (most likely just for testing).

[image: _images/usage.5.png]
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Additional Settings

There are a few additional settings you may want to adjust to fine tune integration with Galaxy.  You can adjust settings by navigating to the Administer > Tripal > Extensions > Galaxy page and click the Settings tab.  Here you will find two settings. One for altering the expiration date for histories on remote Galaxy servers and one for adjusting how often the the Tripal Galaxy module should run the cron.

[image: _images/settings.1.png]
The first setting ensures that results submitted by users do not pile up and use up your file storage quota on the remote Galaxy server.  The second settings adjust how often the Tripal Galaxy cron job runs.  When the cron runs the following actions occur:


	Server Status Checks: All Galaxy servers registered with Tripal are checked to see if they are available. If not then workflows are automatically marked as disabled preventing further submissions. If workflows are disabled, a message is added to the Drupal dashboard.


	History Cleanup: All histories on the remote Galaxy servers that are older than the number of days specified by the History Age Experiation value are deleted.
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Executing Jobs and Tasks


Automatic Job Execution

In a production setting, jobs submitted by end-users should be executed automatically.  There are two ways to automate job subimssion.  First, if you are writing your own application using Option 2: Power an Application, then you will most likely invoke your workflow using the Tripal Galaxy API.  In this case you are invoking the workflow instantly and nothing further is needed.  If you are using Option 1: Automatic Webform Creation, then user submitted workflows are added to the Tripal job managment system.  You can therefore automate job execution by following the directions in the Tripal User’s Guide [https://tripal.readthedocs.io/en/latest/user_guide/install_tripal/automating_job_execution.html] for job automation.


Note

For near instantaneous invocation of workflows consider using the Tripal Daemon Module [https://tripal.readthedocs.io/en/latest/user_guide/job_management.html]. The Tripal Daemon runs as a background service that constantly checks for new jobs and then executes them.
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Tripal Galaxy API


Note

Use of the Tripal Galaxy API requires the installation of the Tripal Galaxy module and the blend4php library [https://github.com/galaxyproject/blend4php]..
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Tripal Galaxy API Overview

Here code examples and brief descriptions are provided for common applications of the Tripal Galaxy API.  Not all arguments for all API functions are thoroughly described. Please see the Tripal Galaxy API Functions page for specific details.


Adding a Galaxy Server

The Tripal Galaxy module allows a site administrator to add a new Galaxy Server to Tripal using an online web interface. However, you can programmatically add a new Galaxy server using the tripal_galaxy_add_galaxy function.  For example:

// Get the current user.
global $user;

// Prepare the information needed for the server.
$data = array(
  'servername' => 'Use Galaxy Public',
  'description' => 'The public server provided by the Galaxy Project,
  'url' => 'https://usegalaxy.org/',
  'username' => 'fakeuser',
  'api_key' => '48eead1213e5dd6d1876811b38b66e51',
  'uid' => $user->uid,
);

// Add the Galaxy server.
$galaxy = tripal_galaxy_add_galaxy($data);





A use case when you may want to programmatically add a new Galaxy server is if you want to provide your own interface for allowing others to add new servers besides the site admin.



Get a List of Galaxies

You can retrieve a list of all Galaxy servers known to Tripal by calling the tripal_galaxy_get_galaxies function.

// Get the list of galaxies.
$galaxies = tripal_galaxy_get_galaxies();

// Iterate through that list to perform actions on each, or retrieve
// information.
foreach ($galaxies as $galaxy) {

  // Get the galaxy ID
  $galaxy_id = $galaxy->galaxy_id;

  // Do stuff here.
}







Connect to Galaxy

Before any communication between Tripal and Galaxy can happen a connection between the two must be made.  Blend4php will allow you to connect directly to a Galaxy instance if you know the URL. However, it is recommended to use the Tripal API to make the connection.

If the site admin has already added a Galaxy server using the web interface then you can connect to the Galaxy server using its internal ID.  The tripal_galaxy_get_connection function can be used. It returns an instance of a  GalaxyInstance.

For example:

// Connect to the Galaxy instance using a galaxy ID we retrieved in an
// earlier step.
$galaxy = tripal_galaxy_get_connection($galaxy_id);

// It is always good to make sure we got a valid connection. If we didn't
// then we can retreive any connection errors using the getError() member
// function.
if (!$galaxy) {
  $error = $galaxy->getError();
  drupal_set_message('Could not connect to Galaxy server. ' . $error['message'], 'error');
}





In the example code above above, the tripal_galaxy_get_connection function returns an instance of the blend4php [https://github.com/galaxyproject/blend4php] GalaxyInstance class that we named $galaxy. This instance is used by all other functions used by blend4php to interact with Galaxy.  To learn more about this object and the functionality it provides please see the blend4php_docs [http://galaxyproject.github.io/blend4php/docs-v0.1a/html/annotated.html].



Test if a Galaxy server is accessible.

If a Galaxy server is not accessible no actions can be performed including workflow submissions, status updates, or results display. A server may not be accessible if it it is offline.  You can check the status of a galaxy workflow with the tripal_galaxy_test_connection function.

$is_connected = tripal_galaxy_test_connection(['galaxy_id' => $galaxy_id]);
if (!$is_connected) {
  // Do something here.
}







Add a Workflow to Tripal

The Tripal GAlaxy module does not allow a user to create Galaxy workflows.  Workflows should always be created on the Galaxy interface.  Once a workflow is created it can be added to Tripal. A site administrator can add new workflows to Tripal using the web interface.  However, you can programmatically add a new workflow using the tripal_galaxy_add_workflow function.  To do this you must know have the ID of the galaxy server and the name or workflow_id of the workflow on the Galaxy server.  You can obtain the name or workflow_id from the Galaxy server by:


	Using the blend4php GalaxyWorkflows::index() [http://galaxyproject.github.io/blend4php/docs-v0.1a/html/classGalaxyWorkflows.html] function and examining the resulting array.


	Directly retrieving a JSON array of results from the Galaxy server’s RESTful API services available at the URL api/workflows (e.g. https://usegalaxy.org/api/workflows).  You can view results in a web browser if you have a plugin for viewing JSON arrays.  You must first login to Galaxy before using the RESTful web services.




$values = [
   'workflow_id' => 'ebfb8f50c6abde6d',
];
$workflow = tripal_galaxy_add_workflow($galaxy_id, $values, TRUE);





The tripal_galaxy_add_workflow will connect to the remote Galaxy server, retrieve the workflow infomation and add it to Tripal.  If you want your site visitors to be able to submit the workflow for execution set the last argument to TRUE to create the web form for the workflow.



Prepare a Workflow for Execution

If a web form was created for a workflow then your site visitors can submit the workflow for execution using the web interface to provide input data and settings.  However, you can submit a workflow programmatically.  To do this, use the tripal_galaxy_init_submission function to first prepare the submission.  For this function you must specify the workflow object and the user that is submitting it.  The workflow object can be retrieved using the tripal_galaxy_get_workflows by providing values to uniquely select it.

// Get the current user.
global $user;

// Provide the values to uniquely find the workflow.
$values = [
  'workflow_id' => 'ebfb8f50c6abde6d',
  'galaxy_id' => $galaxy_id,
]

// Find the workflow using the values. This function always returns an
// array of workflows that match the criteria.  By providing the workflow_id
// and the galaxy_id it should only ever match one workflow.
$workflows = tripal_galaxy_get_workflows($values);
$workflow = $workflows[0];

// We can now initialize the workflow submission.
$sid = tripal_galaxy_init_submission($workflow, $user);

// The submission ID will uniquely identify this submission.  Next get the
// submission object.
$submission = tripal_galaxy_get_submission($sid);





The workflow is now ready to be invoked.



Get a History Name

Before we can invoke a workflow we need to understand Galaxy histories. All data in Galaxy is housed in a data collection referred to as a “history”. Before workflows can be executed, input data must be placed in a history, and after workflow execution, resulting data is found in the history.  For more information about histories in Galaxy you can view the histories tutorial page [https://galaxyproject.org/tutorials/histories/].

When Tripal Galaxy invokes a workflow within Galaxy it will ensure that each invocation uses a unique history with a unique name.  By default Tripal Galaxy module uses a naming schema for histories: TG-[UID]-[WID]-[SID]-[Date].

Where


	[UID] is the user ID of the Drupal user who is submitting/submitted the workflow


	[WID] is the Tripal Galaxy module’s ID for the workflow


	[SID] is the Tripal Galaxy submission ID for the workflow submisiion and


	[Date] is the date that the submission was made.




For example the following is history name that follows this scheme:  TG-1-53-19-2018_10_03_09:31:02

Before invoking a workflow you will need to create the history and you should follow the Tripal naming scheme to name that history.  To retrieve the name for any history use the tripal_galaxy_get_history_name function.

// Retrieve the $submission object using a known submission ID.
$submission = tripal_galaxy_get_submission($sid);

// Get the history name.
$history_name = tripal_galaxy_get_history_name($submission);







Create a History and Upload Files

Before we invoke a workflow we must ensure that the requried input data files are in a history on the remote Galxy server. For loading files from your local Tripal site into Galaxy use the tripal_galaxy_upload_file function.  This function expects that any files you upload to Galaxy are also know by Drupal, therefore you must use the Drupal 7 File API [https://www.drupal.org/docs/7/api/file-api].  The following shows an example for how to do this:

// The current user owns the file.
global $user;

// The Drupal File API uses Streams (i.e public://, private://, etc) which
// point to files within the Drupal directory heirarchy.
$uri = 'public://reads_1.fastq';

// Create a new file object.
$file = new stdClass();
$file->uri = $uri;
$file->filename = 'reads_1.fastq';
$file->filemime = file_get_mimetype($uri);
$file->uid = $user->uid;
$file->status = FILE_STATUS_PERMANENT;
$file = file_save($file);
$fid = $file->fid;

// We don't want the file to disappear when Drupal performs it's cleaning so
// we have to tell Drupal that the file is being used.  See the Drupal
// documentation for the meaning of the input arguments.
file_usage_add($file, 'my_module', 'workflow1_reads', $sid);





Now that Drupal is aware of the file there are a few additional steps before we can upload it to Galaxy. First, we must ensure that a history exists on the remote Galaxy server. Remember, that all workflow submissions use a unique history name. We should use that history name to create the history. The history is created using the tripal_galaxy_create_history function.

// Retrieve the $submission object using a known submission ID.
$submission = tripal_galaxy_get_submission($sid);

// Get the history name.
$history_name = tripal_galaxy_get_history_name($submission);
$history = tripal_galaxy_create_history($galaxy, $history_name);
if ($history === FALSE) {
  $error = $galaxy->getError();
  throw new Exception($error['message']);
}





Next, we need the current contents of the history.  If the history did not exist then the history should be empty.  However, the same workflow submission can be invoked multiple times so we need to get the contents of the history to pass into the tripal_galaxy_upload_file function.

// Get the history contents so we don't upload the same file more than once
// in the event that this invocation occurs more than once.
$ghistory_contents = new GalaxyHistoryContents($galaxy);
$history_contents = $ghistory_contents->index(['history_id' => $history['id']]);
if ($history_contents === FALSE) {
  $error = $galaxy->getError();
  throw new Exception($error['message']);
}





Now we have sufficient information to upload our file to Galaxy. Our file is known to Drupal, we have a history, and we have the history contents.

// Upload the file to Galaxy.
$galaxy_file = tripal_galaxy_upload_file($galaxy, $fid, $history['id'], $history_contents);





The returned $galaxy_file variable contains information about the file on the galaxy server.  We will need this later when invoking the workflow.



Invoke a Workflow

Workflows are the multistep process through which data is submitted, analysed, processed, and then results provided. Workflows are created in Galaxy, they cannot be created in Tripal Galaxy.

For more information on creating and editing workflows please see the online turorial [https://galaxyproject.org/tutorials/g101/#creating-and-editing-a-workflow].

Before invoking the workflow all data files need to be uploaded to a Galaxy history. Examples for how to do this were shown in the previous section. To invoking a workflow use the tripal_galaxy_invoke_workflow function.  It requires two complex arrays: $parameters and $inputs. These provide the tool settings for the workflow and the input files needed to start the workflow. Construction of these arrays will require a good understanding of each workflow’s needs.

For example, consider the following worklow.  It has four steps, with two initial steps providing only input data and the other two using actual analytical tools.

[image: ../_images/galaxy_workflow_canvas.png]
The first two steps require input files. Therefore, we will indicate where these are using the $inputs array.  This is an associative array containing the files used by the workflow and their location in the Galaxy server. An input array may look like the following:

$inputs = [
  [0] => [
    [id] => 70eec96181a992f8,
    [src] => hda,
  ],
  [1] => [
    [id] => 8317ee2b0d0f62d9,
    [src] => hda,
  ],
];





The first-level keys are numeric (e.g. 0 and 1).  These indicate the steps in the workflow that require input.  For each there is an id and src key.  The id is the Galaxy ID for the file. We can retrieve this id from the $galaxy_file array we retrieved above when we called the tripal_galaxy_upload_file function.

The src indicates where the file can be found. The value hda indicates the file is in the History Dataset Assocation (HDA) which is the default history storage location. See the tripal_galaxy_invoke_workflow function definition on the Tripal Galaxy API Functions page for a more in-depth meaning of the $inputs array structure.

Similarly, the $parameters argument is an associative array whose first-level keys are the numeric index for the steps in the workflow and the settings for the tool at each step are provided.

$parameters = [
  [0] => [
    [Data File] => 70eec96181a992f8,
  ],
  [1] => [
    [Data File] => 8317ee2b0d0f62d9,
  ],
  [2] => [
    [expression_data] => [
        [step_output] => output,
        [source_step] => 0,
    ],
    [echo] => no,
  ],
  [3] => [
    [preprocessing_workspace] => [
        [step_output] => preprocessing_workspace,
        [source_step] => 2,
    ],
    [height_cut] => 15,
    [trait_data] => [
        [step_output] => output,
        [source_step] => 1,
    ],
    [echo] => no,
  ],
];





Note that for steps 0 and 1 the setting name is Data File and the value is the file ID used in the $inputs array.  For all other steps, the settings are specified.


Note

Every workflow is different and as such the $input and $parameters arrays will be different from those shown in the examples above.
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Tripal Galaxy API Functions


	
group tripal_galaxy_api

	programming interface (API) for integrating Tripal and Galaxy. It uses the blend4php library to communicate with a remote Galaxy instances but ensures that other developers who want to integrate with the features of the Tripal Galaxy module cab do so. 


Functions


	
tripal_galaxy_add_galaxy(array $values)

	Adds a new Galaxy server to Tripal.


	Return

	object The newly created Galaxy object or FALSE on error. If the record already exists the object is returned and no duplicated record is added. 



	Parameters

	
	$values: An associative array containing the following key/value pairs: - servername: A human-readable name for the Galaxy server. The servername must be unique and not already present. - description: (optional) a description about this server. - url: The full URL for the server (e.g. https://usegalaxy.org/) - username: The name of the user to connect as. - api_key: The API key of the user. This allows Tripal to access the Galaxy server’s RESTful API services. - uid: The Drupal User ID who created this record.















	
tripal_galaxy_add_workflow(int $galaxy_id, array $values, bool $create_webform = TRUE)

	Adds a remote Galaxy Workflow to Tripal.


	Return

	object A workflow object or FALSE on error. If the workflow has already been added, then the workflow object is returned and no duplicate record is added. 



	Parameters

	
	$galaxy_id: An ID of the galaxy server. 


	$values: An associative array used to specify the workflow. The workflow can be identified using the Galaxy workflow ID provided using the ‘workflow_id’ key or using the workflow name provided using the ‘workflow_name’ key. 


	$create_webform: If TRUE, creates a webform for the end-user to submit this workflow using the Tripal website. It will automatically create a history for this workflow on the remote Galaxy server as well.















	
tripal_galaxy_check_submission_status(int $sid = NULL, bool $force = FALSE)

	Checks and updates the status of a Galaxy workflow.


	Return

	bool Returns TRUE on successful checking of the status, FALSE if a problem occured. 



	Parameters

	
	$sid: The submission ID of the workflow. 


	$force: If a workflow submission is already completed this function will quickly return and not check the status again. Setting the $force argument to TRUE will force the function to check the status.















	
tripal_galaxy_create_history(GalaxyInstance $galaxy, string $history_name)

	Creates a history on the Galaxy server.


	Return

	array A history array for the created history. 



	Parameters

	
	$galaxy: 


	$history_name: 















	
tripal_galaxy_delete_expired_histories()


	Deletes expired histories.

Walks through the tripal_galaxy_workflow_submission table and deletes any workflows older in days than specified in the tripal_galaxy_history_days_limit system variable.






	
tripal_galaxy_delete_remote_history(int $galaxy_id, string $history_name)

	Deletes a single remote history from the remote galaxy server.


	Return

	bool TRUE if the deletion was successful, FALSE otherwise. 



	Parameters

	
	$galaxy_id: A unique ID for the galaxy server. If this is provided no other arguments are needed. 


	$history_name: The name of the history to retrieve. If the history doesn’t exist then it will be created.















	
tripal_galaxy_download_file(stdClass $submission, array $dataset, int $uid)

	Downloads a file from a Galaxy history.

Downloads a single file from a history. The file will be stored in the user’s Tripal space and count towards their quota. If the file has already been downloaded it will be retrieved again and overwrite any existing file.


	Return

	object Returns a Drupal File object. 



	Parameters

	
	$submission: A submission object as obtained by the tripal_galaxy_get_submission() function. 


	$dataset: An array describing the dataset as returned by the tripal_galaxy_get_dataset() or tripal_galaxy_get_datasets() functions. 


	$uid: The user that should own this file after it is downloaded.






	Exceptions

	
	Exception: 















	
tripal_galaxy_get_active_submissions()


	Retrieves a list of all workflow submissions that have not completed.


	Return

	array An array of submission objects. 












	
tripal_galaxy_get_connection(int $galaxy_id)

	Retrieves a GalaxyInstance objects using a galaxy_id.


	Return

	GalaxyInstance A galaxyInstance object or FALSE on error. 



	Parameters

	
	$galaxy_id: The ID of a galaxy server.















	
tripal_galaxy_get_dataset(stdClass $submission,  $dataset_id)

	Retrieves a single datasets for a workflow invocation.

This function returns a single datasets as reported by the remote Galaxy server. The key/value pairs of the array are dependent on the Galaxy server version.


	Return

	array An array of datasets as reporte by the Remote Galaxy server. 



	Parameters

	
	$submission: An object for the submission as returned by the tripal_galaxy_get_sumbission() function.


	The: ID of the dataset to retrieve.






	Exceptions

	
	Exception: 















	
tripal_galaxy_get_datasets(stdClass $submission)

	Retrieves a list of datasets for a workflow invocation.

This function returns an array of datasets as reported by the remote Galaxy server. The key/value pairs of the array are dependent on the Galaxy server version.

Note, this function may take a few seconds to complete as it must communicate with the remote Galaxy server to retrieve dataset information.


	Return

	array An array of datasets as reporte by the Remote Galaxy server. 



	Parameters

	
	$submission: An object for the submission as returned by the tripal_galaxy_get_sumbission() function.






	Exceptions

	
	Exception: 















	
tripal_galaxy_get_files_dir()


	Returns the URI where the Tripal Galaxy module stores files.

This function also ensures that the path exists by creating it.


	Return

	string|bool A Drupal URI indicating the location where Galaxy files are housed. Returns FALSE if the location does not exist or cannot be created. 












	
tripal_galaxy_get_galaxies()


	Retrieves a list of Galaxy servers that are known to Tripal.


	Return

	array An associative array of galaxy server objects. Note, the returned objects are different from the GalaxyInstance objects provided by blend4php. These objects house the information that Tripal maintains about each of these servers. 












	
tripal_galaxy_get_galaxy(int $galaxy_id)

	Retrieves a Galaxy object.


	Return

	object A galaxy object Note, the returned object is different from the GalaxyInstance object provided by blend4php. This objects house the information that Tripal maintains about each the servers. Returns FALSE on error. 



	Parameters

	
	$galaxy_id: The ID of the galaxy server to retrieve. A list of all galxy servers known to Tripal can be retrieved using the tripal_galaxy_get_galaxies() function.















	
tripal_galaxy_get_history(GalaxyInstance $galaxy, string $history_name)

	Retrieves a history by name from Galaxy.

You must first create the history using tripal_galaxy_create_history() if it does not already exist.


	Return

	array|bool A history array for the specified history or FALSE if the history could not be found. 



	Parameters

	
	$galaxy: A GalaxyInstance object. 


	$history_name: The name of the history to retrieve. If the history doesn’t exist then it will be created.















	
tripal_galaxy_get_history_name( $submission)

	Constructs the history name for a given submission.


	Return

	string The history name. 



	Parameters

	
	$submission: A submission object that contains the galaxy_workflow_id, sid, and submit_date properties.















	
tripal_galaxy_get_submission(int $sid)

	Retrieves a workflow submission object using the submission ID.

The returned submission object includes all information about the submission. If the submission has been invoked then the ‘errors’ element will have more information about the run including the history information, the history name, and the state of the history_contents from the last time the status of the submission was checked. If the status of the submission is ‘Completed’ then the history_contents should contain all the history contents.


	Return

	object An object containing the submission information. 



	Parameters

	
	$sid: The submission ID of the workflow.















	
tripal_galaxy_get_user_submissions(int $userid)

	Retrieve all submission IDs for a user.


	Return

	array A list of submission ids. 



	Parameters

	
	$userid: User id number.















	
tripal_galaxy_get_workflow_defaults(GalaxyInstance $galaxy, string $workflow_id)

	Retrieves an array of settings used by the workflow.

This is a helpful function to help a developer understand how the $parameters array should be structured when passing into the tripal_galaxy_invoke_workflow() function.


	Return

	bool|array An array compatible with the $parameters argument for the tripal_galaxy_invoke_wokflow(). Values are populatd with appropriate defaults. Returns FALSE if the workflow settings could not be retrieved. 



	Parameters

	
	$galaxy: A GalaxyInstance object. 


	$workflow_id: The ID of the workflow to retrieve settings for. This is the Galaxy ID for the workflow not Tripal’s internal workflow ID.















	
tripal_galaxy_get_workflows(array $values = [])

	Retrieves a list of workflows integrated with Tripal.

The returned workflows can be filtered using a set of matching criteria given by the $values argument. This list only includes workflows that have been integrated with Tripal and not the list of workflows available on a remote galaxy server. Use blend4php functions to retrieve a list of workflows available on a remote Galaxy server.


	Return

	array An array of workflow objects. 



	Parameters

	
	$values: An associative array used to find workflows. The following keys are supported: - galaxy_id: finds all workflows that match the given galayx_id. - id: finds the workflow with this specific workflow ID. - workflow_id: the ID of the workflow on the remote Galaxy instance. - name: finds the workflow with a given name. Note: the workflow name is not guranteed to be unique. - status: finds all workflows whose status matches the value provided. Any combination of the keys can be used.















	
tripal_galaxy_init_submission( $workflow,  $user)

	Initializes a new workflow submission record.

This function creates the record for the submission.


	Return

	int|bool The submission ID on success, FALSE on failure. 



	Parameters

	
	$workflow: An workflow object as generated by the tripal_galaxy_get_workflow() function. 


	$user: The Drupal User object. This is the user who owns the submission.















	
tripal_galaxy_invoke_workflow(GalaxyInstance $galaxy,  $submission, array $parameters, array $inputs, array $history)

	Invokes all submitted workflows that are in the ‘Waiting’ state.

This function can be called by the tripal Job system hence the $job argument. For Tripal v2 the job_id is passed, for Tripal v3 a job object is passed so we’ll handle both cases.


	Parameters

	
	$galaxy: An instance of a GalaxyInstance object. 


	$submission: A Galaxy workflow submission object. This object can be retrieved using the tripal_galaxy_get_submission() function. 


	$parameters: A mapping of tool parameters that are non-datasets parameters. The map must be in the following format: [
  {step_id_or_UUID} => [
    {param_name} => {value}
  ],
  {step_id_or_UUID} => [
    {param_name} =>
    {value}
  ]
];





 


	$inputs: An array of file inputs. These files should already be uploaded to the history on the Galaxy server. This array contains a mapping of workflow inputs to datasets and dataset collections. The datasets source can be a LibraryDatasetDatasetAssociation (ldda), LibraryDataset (ld), HistoryDatasetAssociation (hda), or HistoryDatasetCollectionAssociation (hdca). The map must be in the following format. [
  {step index} => [
    'id' => {encoded dataset ID},
    'src' => {'ldda'|'ld'|'hda'|'hdca'},
  ],
];





 The id’s are data set IDs and can be found using the data set class’s index() function. The data set must be present in a history, and the data set ‘state’ must be ‘ok’ and ‘deleted’ must be set to FALSE. The {step index> is the numeric value of the step in the workflow where the file is used. 


	$history: A history record as returned by the function tripal_galaxy_get_history().















	
tripal_galaxy_test_connection(array $connect)

	Tests if a Galaxy server is accessible.


	Return

	bool Returns TRUE if accessible. FALSE otherwise. A Drupal message is also provided that indicates if the test was successful. 



	Parameters

	
	$connect: An array of the following: - galaxy_id: A unique ID for the galaxy server. If this is provided no other arguments are needed. - host: The DNS hostname of the galaxy server. - port: The TCP port for the server. - use_https: Set to TRUE of the server uses HTTPS If the ‘galaxy_id’ is provided then no other values are needed. Use the host, port and use_https arguments if testing connection to a server that has not yet been added.















	
tripal_galaxy_upload_file( $galaxy, int $fid, string $history_id, array $history_contents)

	Uploads a file to a given history on Galaxy.


	Return

	array An array of the dataset details from Galaxy for the uploaded file. 



	Parameters

	
	$galaxy: An instance of a Galaxy server object. 


	$fid: The Drupal managed file ID. 


	$history_id: The history ID. 


	$history_contents: The Galaxy history contents array as returned by the GalaxyHistoryContents::index function.






	Exceptions

	
	Exception: 























          

      

      

    

  

  
    
    Index
    

    

    
 
  

    
      
          
            

Index



 T
 


T


  	
      	tripal_galaxy_delete_expired_histories (C++ function)


      	tripal_galaxy_get_active_submissions (C++ function)


  

  	
      	tripal_galaxy_get_files_dir (C++ function)


      	tripal_galaxy_get_galaxies (C++ function)


  







          

      

      

    

  
_static/minus.png





_static/plus.png





_static/file.png





_images/api_overview.history.png
localhost:

Mozilla Firefox

140%

n o @

Get Data

Send Data

Collection Operations
Lift-Over

Text Manipulation

Filter and Sort

Join, Subtract and Group
Convert Formats

Extract Features

Fetch uences

Fetch Alignments
Statistics
Graph/Display Data

Workflows

= All workflows

Hello, Galaxy is
running!

To customize this page edit

static/welcome.html

Configuring Galaxy »

Installing Tools »

Take an interactive tour:

Galaxy Ul | | History | | Scratchbook

Galaxy is an open platform for supporting data
intensive research. Galaxy is developed by

The Galaxy Team with the support of many
contributors.

The Galaxy Project is supported in part by NHGRI,
NSF, The Huck Institutes of the Life Sciences, The
Institute for CyberScience at Penn State, and Johns
Hopkins University.

History [ 4]

TG-1-80-28-2018 12 05 16:26:37
7 shown

12.04 MB “®e

@ & %

@ & %

1: expression_data.csv ® & x






_static/up-pressed.png





_images/automating_tasks.manual.1.png
@ Analysis Results | Tripa! +

c @

localhost, n o @

Home » Administration » Tripal » Extensions » Galaxy

Analysis Results o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS
Workflow User Submission Status
Is equal to M
B]
Apply
GALAXY SUBMISSION
ID | WORKFLOW USER START TIME END TIME STATUS RESULTS
SERVER TIME
Differential Gene Local 12/06/2018 - 12/15/2018-  12/15/2018 -
30 administrator Completed  View
Expression (DESeq2) Galaxy 14:42 19:58 19:58
Co-Expression Network ~ Local 12/06/2018 - 12/15/2018-  12/15/2018 -
29 administrator Completed ~ View
Construction (WGCNA) Galaxy 14:41 20:09 20:16
Co-Expression Network ~ Local 12/05/2018 - 12/15/2018-  12/15/2018 -
administrator Completed  View
Construction (WGCNA) Galaxy 16:26 19:53 20:00





_static/up.png





_images/install.1.png
@ Galaxy| Tripalv3 Exam

<« c @ Yino @ =

130%

Edit shortcuts

Home » Administration » Tripal » Extensions

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

+ Add Galaxy Instance

‘GALAXY SERVER DESCRIPTION STATUS OPTIONS

No Galaxy instances have been added.





_images/install.2.png
File Edit View History Bookmarks Tc

@ People | Tripalv3
€ @ localhost; E1 110% | G |[Q searc tE A

A Dashboard Content Structure Tipal Appearance ( EESPEJ) Modules Configuration  Reports e Log out

Add content  Add Tripal Content ~ Find content  Find Tripal Content Edit shortcuts

ANONYMOUS  AUTHENTICATED
PERMISSION ADMINISTRATOR
USER USER

al Galaxy

Execute Published Galaxy Workflows _
Allows a user to submit a published workflow for execution on a remote Galaxy Instance

Administer Galaxy - -

Allows a user to configure site-wide default Galaxy instances.





_images/galaxy_api_example.png
localhost:8080/api/workFlo X

<> C @ ) localhost:8080/api/workFlows/1cd8e2f6b131e891 153%) | e @ T viND @ =
JSON  RawData  Headers
Save Copy Collapse All Expand All Filter JSON

Lype: uata_input

annotation: "Rows in the CSV file are samples and columns are traits."

2:

tool_id: "toolshed.g2.bx.psu.edu/repos/mingchen0919/rmarkdown_wgcna/wgcna_preprocessing/1.0.2"

tool_version: "1.0.2"

id: 2

input_steps:
expression_data:

step_output: "output"
source_step: ]
tool_inputs:
__page_ : ]
__rerun_remap_job_id__: null
chromInfo: "\"/galaxy-central/tool-data/shared/ucsc/chrom/?.len\""
expression_data: "{\"__class__\": \"RuntimeValue\"}"
echo: false\""
type: "tool"
annotation: null
3:
tool _id: "toolshed.g2.bx.psu.edu/repos/mingchen0919/rmarkdown_wgcna/wgcna_construct_network
/1.0.2"
tool_version: "1.0.2"
id: 3
input_steps:
trait_data:
step_output: "output"
source_step: 1

preprocessing_workspace:
step output: "preprocessing workspace"
wgcna A~ [ v || Highlight All Matchcase WholeWords 1 0f 7 matches x





_images/galaxy_workflow_canvas.png
Workflow Canvas | wgcna-analysis (imported from uploaded file) (imported from uploaded file) -3

) Gene expression data
wgcna_preprocessing (html)
preprocessing_workspace (rdata)

R workspace from WGCNA:
preprocessing

output O  Trait data

wgcna_construct_network (htmi)

construct_network_workspace (rdata)






_images/remote_servers.1.png
Galaxy | Tripal v3 Exam

<« e e n o @

localhost; 130%

Hello administrator  Log out
oard Content Structure (@MPSN) Appearance People Modules  Configuration Reports  Help

Add content  Add Tripal Content  Tripal Content Edit shortcuts

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS
GALAXY SERVER DESCRIPTION STATUS OPTIONS

No Galaxy instances have been added.





_images/remote_servers.2.png
@ Galaxy| Tripalv3 Exam

CcC localhost, Lo D@

Home » Administration » Tripal » Extensions » Galaxy

Galaxy © 'WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

Galaxy Server Name *

Please provide the name of the remote Galaxy Server

Description

Provide any additional details about this server.

URL *

The URL for the remote Galaxy server.

User Name

The user name for the Galaxy server. This username is used to launch all jobs by default. If this field is left blank then it is expected that
the user has an account on the Galaxy server and will provide their username when executing workflows.






_images/remote_servers.3.png
@ Galaxy| Tripalv3 Exam

<« c @ localhost; 130% Lo D@

&) -

ntent Add Tripal Content Tripal Content

Home » Administration » Tripal » Extensions

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

o Galaxy instance has been added

+ Add Galaxy Instance

‘GALAXY SERVER DESCRIPTION STATUS = OPTIONS

Use Galaxy Public The Galaxy Project's public server. Does not provide all tools that may be needed, size edit | test
Server and responsiveness is limited. |





nav.xhtml

    
      Table of Contents


      
        		
          Tripal Galaxy Extension Module
        


        		
          Install Tripal Galaxy
          
            		
              Installation
            


            		
              Set Permissions
            


          


        


        		
          Option 1: Automatic Webform Creation
          
            		
              Site-wide Files
            


            		
              Adding a Remote Galaxy Server
            


            		
              Adding a New Workflow
            


            		
              Set User Quotas
            


          


        


        		
          Option 2: Power an Application
        


        		
          Workflow Settings
          
            		
              Customizing Emails
            


          


        


        		
          Monitoring Usage
          
            		
              The Job Queue
            


            		
              Usage Stats
            


          


        


        		
          Additional Settings
        


        		
          Executing Jobs and Tasks
          
            		
              Automatic Job Execution
            


            		
              Automatic Job Status Checking
            


            		
              Automatic Housekeeping
            


            		
              Manually Execute Jobs
            


          


        


        		
          Tripal Galaxy API
          
            		
              Tripal Galaxy API Overview
              
                		
                  Adding a Galaxy Server
                


                		
                  Get a List of Galaxies
                


                		
                  Connect to Galaxy
                


                		
                  Test if a Galaxy server is accessible.
                


                		
                  Add a Workflow to Tripal
                


                		
                  Prepare a Workflow for Execution
                


                		
                  Get a History Name
                


                		
                  Create a History and Upload Files
                


                		
                  Invoke a Workflow
                


                		
                  Check the status of a workflow submission
                


                		
                  Retrieving Results from Galaxy
                


              


            


            		
              Tripal Galaxy API Functions
            


          


        


      


    
  

_images/site_wide_files.2.png
@ Galaxy| Tripalv3 Exam

localhost, LN D@ =

Home » Administration » Tripal » Extensions » Galaxy » Files

Galaxy o

Use the following form to provide a new file to be made available to Galaxy workflows. These files can be uploaded or provided
via a remote URL.

File Upload
FILE SIZE UPLOAD PROGRESS ACTION

Browse... | No file selected.

Remember to click the "Upload" button below to send your file to the server. This interface is capable of uploading very large files. If you
are disconnected you can return, reload the file and it will resume where it left off. Once the file is uploaded the "Upload Progress" will
indicate "Complete”. If the file is already present on the server then the status will quickly update to "Complete”.

Upload File

Remote path

B

If the file is available via a remote URL please provide the full URL here. The file will be downloaded when the importer job is executed.

Type *

The type of file (e.g. fasta, or fasta, etc.). This file can then be used for any Galaxy workflows that has this type in its list of allowed input
types.

Short Description *

Please provide the description that will be shown to users for this file.





_images/site_wide_files.3.png
@ Galaxy| Tripalv3 Exam
<« c @

localhost; 130% LN D@ =

Hello administrator

Add content  Add Tripal Content  Tripal Content

Home » Administration » Tripal » Extensions » Galaxy

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

o Succesfully added new site-wide file for Galaxy workflows.

+ Add a New File

The following files will be made available to users inside of Galaxy workflows if the allowed types of the data input match the
specified file type.

Files for Workflows
FILE SHORT DESC PATH TYPE ENABLED ACTIONS
JGI v1.1 Citrus . "
R ftp://ftp.bioinfo.wsu.edu/species
sinensis.
Csinensis_154_v1.fa [Citrus_sinensis/C.sinensis_JGI_v1.1_genome fasta  Yes Edit | Disable | Delete

genome o
Jassembly/Csinensis_154_v1.fa
assembly =





_images/settings.1.png
@ Galaxy| Tripalv3 Exam

<« c @ LN @

Content ~ Structure e Modules Configuration s Hel Hello administrator  Log out

d content  Add Tripal Con Tripal Content t shortc

Home » Administration » Tripal » Extensions » Galaxy

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

History Age Expiration (in days) *
60

Delete histories on remote galaxy server after how many days?

‘Galaxy cron run (in minutes) *
60

How frequently the galaxy cron run should happen. We recoomend at least once per day as workflow expiration is tied into this.

Save Changes





_images/site_wide_files.1.png
@ Galaxy| Tripalv3 Exam

<« c @ localhost, 130% LinoDm@m =

Home » Administration » Tripal » Extensions » Galaxy

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

+ Add a New File

The following files will be made available to users inside of Galaxy workflows if the allowed types of the data input match the
specified file type.

Files for Workflows
FILE SHORT DESC PATH TYPE ENABLED ACTIONS

There are no site-wide files currently shared with for workflows.





_images/usage.3.png
@ WorkFlow submission

LN @

Analysis Name
Co-Expression Network Construction (WGCNA)

~SUBMISSION DETAILS

'WORKFLOW NAME Co-Expression Network Construction (WGCNA)
SUBMISSION ID 28

WORKFLOW ID 1lcdBe2f6b131e891

INVOCATION ID e85a3be143d5905b

STATUS Processing

SUBMISSION DATE Wed, 12/05/2018 - 16:26

HISTORY NAME TG-1-80-28-2018_12_05_16::

START TIME

END TIME

Local Galaxy

‘GALAXY SERVER
Galaxy
TR et ctabe f th

Results

Furmrantly na rectilbe o

Drrraccing





_images/usage.4.png
@ Analysis Results | Tripa

€)>C @ ® localhost/admin/tripal/exte 3 eve 120% * Lo oo

Tripal e People s Hello administrator  Log

Add cont Add T n Tripal Co

Home » Administration » Tripal » Extensions » Galaxy

Analysis Results o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS
‘Workflow User Submission Status
Is equal to :I
6]
Apply
GALAXY SUBMISSION
ID | WORKFLOW USER STARTTIME | END TIME STATUS RESULTS.
SERVER TIME
Co-Expression Network  Local 12/05/2018 - 12/05/2018-  12/05/2018 -
administrator Completed  View
Construction (WGCNA) Galaxy 16:26 16:34 16:43





_images/usage.1.png
@ Analysis Results | Tripa

<« c @ @ localhost/admin/ts extes g eue 120% . ¥ INn@D @ =

A Dashboard  C e ce e es  Configuration

Add content

Home » Administration » Tripal » Extensions » Galaxy

Analysis Results o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS
‘Workflow User Submission Status
Is equal to :I
6]
Apply
GALAXY SUBMISSION START END
ID | WORKFLOW USER STATUS | RESULTS
SERVER TIME TIME TIME
Co-Expression Network 12/05/2018 - "
Local Galaxy ~ administrator Waiting  View
Construction (WGCNA) 16:26





_images/usage.2.png
Send Data

Collection Operations
Lift-Over

Text Manipulation
Filter and Sort

Join, Subtract and Group
Convert Formats
Extract Features
Fetch Sequences
Fetch Alignments
Stati

GraphiDisplay Data

Workflows
= All workflows

Hello, Galaxy is running!
To customize this page edit

static/welcome.html

Configuring Galaxy » [ Installing Tools »

Take an interactive tour: | Gaiaxy ul || History || Scratchbook

Galaxy is an open platform for supporting data intensive research.

Galaxy is developed by The Galaxy Team with the support of many
contributors.

The Galaxy Project is supported in part by NHGRI, NSF, The Huck Institutes of the
Life Sciences, The Institute for CyberScience at Penn State, and Johns Hopkins
University.

History [s - Jun)

©
TG-1-80-28-2018 12 05 16:26:37
7 shown
7.24MB A 3 d
@ Z:WGCNA: eigengene x
visualization
® &%
® &%
® &%
® &%
@® &%
@® &%
>





_images/usage.5.png
@ Galaxy| Tripal X

¢ @ ® localhost/admin/tr

extension/galaxy/usage

Top 10 Submitters

The following bar chart shows the top 10 users that have submitted workflows.

administrator

Top 10 Workflows Submitted

The following bar chart shows the top 10 workflows that have been submitted.

0 1 2 3

e

DEG Analysis (Deseq2)

'WGCNA Analysis 1

‘Sequence QC (single-end)

¥

dministrator

n o @





_images/workflow_settings.1.png
Galaxy | Tripal v3 Example - Mozilla Firefox

@ Galaxy | Tripal v3 Examp X

<« CcC @ localhost, 130% o w no@E =

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

+ Add Workflows

GALAXY
ID  WORKFLOW NAME STATUS = ACTIONS
SERVER
Webform Title:
Differential Gene Expression (DESeq2) )
81 Local Galaxy ~Active  Settings | Disable | Remove
Workflow Name:
differential-expression-deseq2-analysis (imported from uploaded file)
Webform Title:
Co-Expression Network Construction (WGCNA) )
80 Local Galaxy ~Active  Settings | Disable | Remove
Workflow Name:

wgcna-analysis (imported from uploaded file)





_images/workflow_settings.2.png
WorkFlow Settings: Co-Expression Network Construction (WGCNA) | Tripal v3 Example - Mozilla Firefox

@ Workflow Setti

<« c @ ® localhost, n o @

Home » Administration » Tripal » Extensions » Galaxy » Workflows

Workflow Settings: Co-Expression Network Construction (WGCNA) o

~EMAIL MESSAGE ON SUCCESS

Set the subject and body for emails that are sent to users when the workflow successfully completes. You may use

the tokens as placeholders for values appropriate for the workflow, site and user. If nothing is provided then the
defaults will be used.

Do not send email on success

Subject Line
Your job at [site_name] has completed!

Enter the text that should appear on the subject line.

Email Body

[ou recently submitted a job titled: [workflow_title].
This job has completed.

‘You may view restlts of this job at [results_link].
Thank you.

Enter the text that should appear in the body of the email.

» AVAILABLE TOKENS

» EMAIL MESSAGE ON FAILURE





_images/workflows.2.png
@ Galaxy| Tripal v3 Exa

laxy

<« c @ ® localhost; 130% LN @ =

Dashbo content  structure (@BE) Appearance People  Modules uration  Reports  Help Hello administrator  Log out

Add content  Add Tripal Content Tripal Content Edit shortcuts

Home » Administration » Tripal » Extensions » Galaxy » Workflows

Galaxy o

Galaxy Servers
Select :I

Please select a galaxy instance to view it's workflows





_images/workflows.3.png
@ Galaxy| Tripalv3 Exam

<> e localhost/admin/tripal/ext vmnoe=

Home » Administration » Tripal » Extensions » Galaxy » Workflows

Galaxy o

Galaxy Servers
Local Galaxy :I

Please select a galaxy instance to view it's workflows

ADD WORKFLOW WORKFLOW NAME WORKFLOW ID
wgcna-analysis (imported from uploaded file) 1lcd8e2f6bl131e891
mapping-hisat2-single-end 33b43b4e7093c91f
differential-expression-deseq2-analysis (imported from uploaded file) ebfbsf50c6abde6d
blast-protein-sequence (imported from uploaded file) 597429621d6eb2b
bowtie2-alignment-pe-dataset-collection (imported from uploaded file) f2db4lelfa331b3e

Submit





_images/workflow_settings.3.png
WorkFlow Settings: Co-Expression Network Construction (WGCNA) | Tripal v3 Example - Mozilla Firefox

@ Workflow Settings: Co-- X

<« CcC @ localhost, 130% o w no@E =

Hello administrator

Help

Enter the text that should appear in the body of the email.

~AVAILABLE TOKENS

Use any of these tokens in the subject line or body of your email. Appropriate values will be substituted in their

place.
TOKEN DESCRIPTION
[site_name] The name of this site
[workflow_title] The title of the workflow.
[submission_init] The time when the workflow was submitted to Tripal for execution.

[submission_start] The time when the submitted workflow started.

[submission_end] The time when the submitted workflow ended.

[submission_status] ~ The current status of the sumbitted workflow.

[user_name] The name of the user that submitted the workflow.

[jobs_link] A link to the page where all submitted workflows are listed for the user.

A link to the results page for the workflow. This link is only valid if the workflow completes

[results_link]
- successfully.

» EMAIL MESSAGE ON FAILURE

» EMAIL MESSAGE ON SUCCESS





_images/workflows.1.png
@ Galaxy| Tripalv3 Exam

<« c @ localhost; 130% Lo D@

Home » Administration » Tripal » Extensions » Galaxy

Galaxy o WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

+ Add Workflows

1D 'WORKFLOW NAME ‘GALAXY SERVER STATUS ACTIONS

There are no workflows

Submit Changes





_images/workflows.6.png
@ Edit Webform wgcna-a

<« c @ @ localhost, 14 LN D@ =

edit 110%

administrator L

Edi

Home » wgcna-analysis (imported from uploaded file)

Edit Webform wgcna-analysis (imported from uploaded file) o

VIEW EDIT MANAGE DISPLAY WEBFORM RESULTS DEVEL

Title *

wgcna-analysis (imported from uploaded file)

Menu settings

Provide a menu link
Not in menu

Revision information
No revision

URL redirects
No redirects

Comment settings
Closed

URL path settings.
No alias

Authoring information

By administrator on 2018-12-05
15:41:47 -0800

Publishing options
Published

Save Preview Delete





_images/workflows.7.png
@ Co-Expression Networ

<« c @

#  Dashboard nt

@ localhost, e/4! ebForm

Add content  Add Tripal Content Tripal

Home » Co-Expression Network Construction (WGCNA)

Co-Expression Network Construction (WGCNA) o

w LN @

ello administrator

VIEW | EDIT  MANAGEDISPLAY  WEBFORM  RESULTS DEVEL
Conditionals  E-m: Form settings  Export  Import
Show row weights
LABEL FORMKEY  TYPE VALUE REQUIRED  OPERATIONS
alaxy_webfor
4 Step 1: Instructions 'g“ faxy s Fieldset - Edit Clone Delete
alaxy_webfor SPEERI
4 Step 1: Instructions '9“ £ Markup can submit Edit Clone Delete

step_2_pageb
% Step2 P2 pagel
reak
Step_0_annot
Descripti X
+ o ation_fieldset
Step_0_annot

“+ workflow step annotation
ation_markup

Step_0_field:
“ step 2: Data File : ep_0_fieldse
4+ Data File tep27
4 step3 step_3_pageb
reak

“ Description Step_1_annot
ation_fieldset
Step_1_annot

“+ workflow step annotation
ation_markup

Step_1_fieldse

“ Step 3: Data File N

“+ Data File

step 3 12

an...

Page break - Edit Cone Delete

Fildset E Edit Cone Delete
At this stey

Markup e, P Edit Clone Delete

Fildset E Edit Cone Delete

File - Edit Cone Delete

Page break E Edit Cone Delete

Fildset - Edit Cone Delete
At this step,

Markup ISEEDE Edit Clone Delete
comma...

Fildset - Edit Cone Delete

File E Edit Cone Delete





_images/workflows.4.png
@ Galaxy| Tripalv3 Exam

<« c @

localhost/admin/t: extensi g fl

130% LN @

SEESD) Appe

Home » Administration » Tripal » Extensions » Galaxy

Galaxy o

'WORKFLOWS JOB QUEUE USAGE FILES SETTINGS

0 The workflow was succesfully added!

Sometimes these workflows need a bit of tweaking to make them more intuitive for users. Click the title of the workflow below to
customize how it will appear to users. Consider improving:

« The workflow title.

« The instructions for the workflow.

« The "About this step" field for each tool to help the user understand the workflow.
» Each tool setting descriptions as desired.

+ Add Workflows

1D 'WORKFLOW NAME

GALAXY SERVER STATUS ACTIONS
Webform Title:
wgcna-analysis (imported from uploaded file) )

80 Local Galaxy Active Remove | Disable
Workflow Name:

wgcna-analysis (imported from uploaded file)

Submit Changes





_images/workflows.5.png
@ wgcna-analysis (importe X

<« c @ Yino @ =

localhost/node/488 T10%

administrator  Log

Edi

a wgcna-analysis (imported from uploaded file)

View || Edit || Manage display | Webform || Results || Devel

O
B Submitted by administrator on Wed, 12/05/2018 - 15:41
) o
e Step 1 Step 2 Step3 Step4 Step5 Step 6 Preview Submit

o Array Design Search
o Assay Search
© BLAST Results Search

Page 1 0of 8 (0%)

o Biological Sample Search - Step 1: Instructions

© Biomaterial Search Here you can submit an analysis for execution. This analysis makes use of several bioinformatics tools with
© Company Search each tool provided as a separate step in this workflow. As you move from step to step in the form you can alter
O @mrmtEsh tool settings to control how the tool performs. Some tools may not have settings or use output from tools that

© Cultivar (germplasm appeared as a previous step. Optional settings may be provided.

Variety) Search

© DNA Library Search Execution of this workflow is supported by Galaxy.

o Gene Search

© Generated Germplasm
(breeding Cross) Search

o Genetc Map Search =

Galaxy

o Genome Annotation Search

© Genome Assembly Search This workflow uses the following tools:

© Genome Project Search

© Germplasm Accession
Search

o Heritable Phenotypic « WGCNA: construct network (version 1.0.2): Construct gene network.
Marker Search

o InterPro Results Search

o KEGG Results Search

+ WGCNA: preprocessing (version 1.0.2): Data cleamning and preprocessing.

« WGCNA: eigengene visualization (version 1.0.2): Eigengene visualization.

o Map Search
o Network Search
o e Next Page >
o Nucleic Acid Library
Search
o Organ Search

' Organism Search





_images/workflows.9.png
@ Co-Expression Networ

<« ¢ @ localhost/node/488 B (0% TG -]

People  Modules  Configuration s Hel Hello administrator  Log out

Tripal Content it shor

Q Co-Expression Network Construction (WGCNA)

View || Edit | Managedisplay | Webform | Results || Devel

Data Search Submitted by administrator on Wed, 12/05/2018 - 15:41
L
© Analysis Search Step 1 Step 2 Step 3 Step 4 Step 5 Step 6 Preview Submit

© Array Design Search

o Assay Search Page 1 of 8 (0%)

© BLAST Results Search .

© Biological Sample Search © S I8 MERETS

© Biomaterial Search Gene Co-Expression Networks GCNs are often used to help identify groups of genes that are co-functional.

© Company Search The analysis requires  file containing a Gene Expression Matrix (GEM) containg gene expression levels

© Qi erzh derived from either RNA-seq or microarray data sets. Genes that tend to be expressed at similar levels

across a set of samples are considered co-expressed. A correlation value (often Pearson's or Spearman's

correlation) is assigned to each gene pair. WGNCA is an R-based package that performs pair-wise gene

— correlations and uses a method referred to as soft-thresholding to cull pair-wise correlation values that are

0 @@t non signficant. To learn more about WGCNA and co-expression network construction please see the
(breeding Cross) Search WGCNA homepage.

© Genetic Map Search

© Cultivar (germplasm
Variety) Search
© DNA Library Search

o Genetic Marker Search EditExecution of this workflow is supported by Galaxy.
o Genome Annotation Search
© Genome Assembly Search

© Genome Project Search

s — — =_Galaxy

Search

© Heritable Phenotypic

Marker Search This workflow uses the following tools:
o InterPro Results Search
© KEGG Results Search © WGCNA: preprocessing (version 1.0.2): Data clearning and preprocessing.

© Map Search

« WGCNA: construct network (version 1.0.2): Construct gene network.






_images/workflows.wgcna.png
Galaxy | WorkFlow Editor

LN @

¢

@ [ owats
T —
‘Consruct gen network.

(Gataxy version102)

Label

[
Aadasep el

[T em—p—"
paciage o conseucion ol gene -
P — ax xessonnewors. 1uses e
Gesizaton procesed Gewand sasdan.

nek a8 oo o e B .
nncasons s aaiane nen .

wgena_egengene. veualzaton () wodousvewsd
Ruorkspace fom WGCHA:
worktous preprocessing

a it reprocessing_woispacs”
(a)
@ e
P e sampie duserng pTom
WGCNA prepraceseng and choose 3
heihtcut et removeauters £
e s notauter eave i e ik

i dsta

am it v, da ()
frasdan s provded.aplotconssing
ofsample cusarngand eatheamnap

e generang Tasseld sopsona!






_images/workflows.8.png
@ Edit component: Step

<« c @ w Yino @ =

administrator

Add content  Add Tr t Trip

Label *
Step 1: Instructions
This is used as a descriptive label when displaying this form element.

Form Key *
‘galaxy_webform

Enter a machine readable key for this form element. May contain only alphanumeric characters and underscores. This key will be used as the name attribute of the form element.
This value has no effect on the way data is saved, but may be helpful if doing custom form processing

Q b3

» B

A- B R

Here you can submit an analysis for execution. This analysis makes use of several bioinformatics tools with each tool provided as a separate step in this
workflow. As you move from step to step in the form you can alter tool settings to control how the tool performs. Some tools may not have settings or use
output from tools that appeared as a previous step. Optional settings may be provided.

Execution of this workflow is supported by Galaxy.

=_Galaxy

This workflow uses the following tools:

* WGCNA: preproc